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TOPIC -----------------------------------------------------------

This article is the At Ease 3.0.3 Updater ReadMe file, and it contains important
information about the At Ease 3.0.3 Updater.

DISCUSSION ------------------------------------------------------
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The At Ease 3.0.3 Updater updates At Ease 3.0 or At Ease for Workgroups 3.0,
3.0.1, or 3.0.2 to the latest version, 3.0.3. The changes in version 3.0.3
primarily affect non-workgroups users because previous updates have addressed
many problems in the workgroups product.

At Ease for Workgroups 3.0.2 users do not need to update to version 3.0.3. All
problems with the workgroups product discussed in this document were corrected
in At Ease for Workgroups version 3.0.2. (The only change to version 3.0.2 in
this update is the correction of a rare problem with the login dialog box: if
the login dialog box shows only the user list—not the workgroups list—and the
user cancels out of the dialog box, the user list may disappear.)

Since this document gives information on updating both At Ease and At Ease for
Workgroups, items that apply only to the workgroups product are indicated by
"[WG]."

Requirements for Updating
=========================

Version 3.0 Already Installed
-----------------------------
You can use the Updater only on a workstation that has version 3.0 or later
installed. The Updater will not run if you have an older version (2.x or
earlier) of At Ease installed. If you have an earlier version of At Ease, you
should first update it to version 3.0, then use the Updater.

[WG] Updating Some or All Workstations
--------------------------------------
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The databases used by At Ease 3.0, 3.0.1, 3.0.2, and 3.0.3 are fully compatible.
This means that if you are updating the workgroups version of At Ease, you can
update some At Ease workstations on the network and not others. To benefit from
all the enhancements in this version, however, you should update all At Ease
workstations.

[WG] Using an AppleShare Server for At Ease for Workgroups
----------------------------------------------------------
If your At Ease server is an AppleShare volume, all At Ease workstations on the
network must have version 3.0 installed. If any workstation with an older
version of At Ease tries to access the server, a message will appear reporting
that the At Ease Preferences file is bad.

Updating Procedure
==================

Installation Options
--------------------
There are two ways of updating one or more machines using At Ease: by using the
Updater's floppy disk on each workstation or by installing the updated software
over the network.

Files the Updater Needs to Locate
---------------------------------
In most cases, the Updater attempts to locate and update the At Ease and At Ease
Startup files automatically. If it cannot find either of these files, it will
ask you for the location of the missing file. If you cannot find the file, you
can click the Skip button to cancel the update, leaving your files untouched. If
you have more than one copy of the setup program on your disk, the Updater will
require that other copies be removed before the update can take place. You can
have the Updater remove the other copies automatically, or you can cancel the
update and remove them manually using the Finder.

Some administrators remove the setup program on certain workstations. On these
workstations, the Updater will ask you to locate the setup program. If you are
updating the workgroups version of At Ease and cannot locate the program, click
the Skip button to bypass this request.

If you are updating the non-workgroups version of At Ease, it is highly
recommended that you update the setup program when requested. Since the Updater
will probably turn off At Ease on your workstation after it has completed the
update, you will need an updated setup program in order to turn At Ease back on.
Therefore, it is best not to skip the update.

Updating From the Floppy Disk
-----------------------------
Follow these steps to update At Ease from the floppy disk:

1. Turn off At Ease on each workstation that you are updating. (See the
   user's manual for instructions on how to do this, if necessary.)

2. Insert the Updater disk.
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3. Double-click to open the At Ease 3.0.3 Updater application.

4. Click Begin in the opening screen.

5. If the Updater cannot find a file it needs to update, a message appears
   asking you to locate that file. If you cannot find the file, click Skip
   to cancel the update.

6. If necessary, locate any missing files and start the update again.

[WG] Updating Over the Network
------------------------------
1. Copy the Updater application to an AppleShare server volume to which
   your At Ease workstations have access.

2. Make sure the application is locked. (To do this, select the Updater's
   icon, choose Get Info from the File menu, then click to put an X in the
   checkbox labeled "Locked.")

3. Turn off At Ease on each workstation you are updating.

Tip: Before updating any workstations on the network, you may want to turn off
At Ease on all machines you will be updating by using the Update Computers
feature. After you have updated your At Ease machines, you can turn At Ease on
using this same feature. (See the user's manual for instructions, if
necessary.)

4. Mount the server volume that contains the Updater application.

5. Double-click to open the Updater application.

6. Click Begin in the opening screen.

Using an Updated Copy of the Administration Program
---------------------------------------------------
Be sure to update the copy of At Ease Setup or At Ease Setup (Workgroups) that
you use to administer At Ease to version 3.0.3. You should also remove any old
copies of this program from your hard disk (or disks).

New Desktop Printer Extension
-----------------------------
The Apple Extras folder on your Updater disk contains an updated version of the
Desktop Printer Extension, an extension used by printer drivers for many newer
models of printers. This version of the extension corrects problems that may
occur when you are in the restricted Finder mode in At Ease.

You need to install this extension (version 1.03 or later) only if you are using
an older version of it. If the Desktop Printer Extension is not already in the
Extensions folder in your System Folder, or you have a newer version of the
extension, do not install it. (Installing this extension will not affect
computers that do not already have it, but the extension will occupy a small
amount of memory.) If you are not sure what version of the extension you have,

..TIL20661-At_Ease_3-0-3_Updater_Read_Me_11-96_(TA36229).pdf



select it and choose Get Info from the File menu.

To install the extension, follow these steps:

1. Open the Apple Extras folder on the Updater disk.

2. Drag the Desktop Printer Extension icon to the System Folder on your
   hard disk.

3. Click OK each time a message appears.

Changes Made In Previous Versions
=================================

[WG] Using the Lock Startup Disk Feature
----------------------------------------
A bug in version 3.0.1 prevents the Lock Startup Disk feature from working
correctly. Although the feature may appear to be active (indicated by a
checkmark in the box next to the feature), it may not be active, in which case
users will be able to view the startup volume by starting up from a floppy disk
(or another volume). After updating your computers to version 3.0.3, you should
first attempt to make sure the feature is disabled, quit the administration
application, and then re-enable it. This will ensure that the latest update code
is installed on your startup disk.

Note that this feature does not work on all Macintosh computers. You should read
the section "Disk Security," later in this document, to find out about the
compatibility of this feature with your computer.

System Startup Crashes While Using Open Transport
-------------------------------------------------
A change to the At Ease Startup extension in this version corrects a problem
with system crashes on 68K machines that have Open Transport networking enabled.
(This problem may also show up on certain PowerPC machines, notably the Power
Macintosh 7500.)

[WG] Possible Hard Disk Corruption on IDE Hard Disks When Using the Lock Startup
Volume Feature
-------------------------------------------------------------------------
This version of At Ease prevents a possible hard disk corruption that can occur
when the Lock Startup Volume feature is activated on some newer computers using
an IDE (ATA) internal hard disk. These computers include the Macintosh PowerBook
190, PowerBook 2300, and PowerBook 5300, but not the Macintosh Quadra 630. If
this problem occurs, the computer displays a "sad Macintosh" icon when
restarted.

Version 3.0.3 does not repair an already affected hard disk. If your hard disk
has been corrupted, the At Ease-IDE Utility allows you to recover your hard
disk. This utility is available on the Updater disk. See the At Ease-IDE Utility
Read Me for additional information.

[WG] sub-launching Applications From Other Applications
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------------------------------------------------------
For security, At Ease does not normally allow applications to open, or
sub-launch, other applications. You can allow users to sub-launch applications
in At Ease in one of two ways: (a) by installing the sub-launched application in
the user's setup; or (b) by choosing the Application Preferences command from
the Options menu in At Ease Setup and clicking to put an X in the checkbox
labeled "Can be launched by other applications" for each sub-launched
application.

Version 3.0.1 provides one simple way to allow sub-launching for all
applications. The User Settings dialog box (which you open by choosing User
Settings from the Security menu) now contains a checkbox labeled "Always permit
sub-launches." When this checkbox is selected, At Ease always allows
applications to open other applications. (This setting takes precedence over any
setting in the Application Preferences dialog box.)

By selecting this option, an administrator avoids having to select individual
applications for sub-launching. The checkbox can best be thought of as a
"compatibility mode" feature that allows many applications to work better.

Login Procedure
---------------
To improve login speed, At Ease no longer saves panel or page information. Thus,
when a user logs back in to the panels environment, she or he will always be
brought to the first page of the "brown" panel.

[WG] At Ease Setup Changes
--------------------------
When At Ease Setup starts up, it now checks the internal databases. This check
can take from a few seconds (when no users are logged in to the At Ease server)
to almost a minute (on slow networks, when users are already logged in to At
Ease). A message informs you that this check is taking place.

Clarifications
==============

Using Kid Pix Studio (Correction to Read Me for At Ease 3.0)
------------------------------------------------------------
In the Read Me file for At Ease 3.0, the section "At Ease for Workgroups 3.0 and
Kid Pix Studio" explains how to use At Ease 3.0 with Kid Pix Studio. The
information about setting up subprograms with the Application Preferences
command contains an error for the file "KPS 5." The file creator for "KPS 5"
should be "Kîd5," not "Kîd4."

NOTE: To create the î character, hold down the Option key and type the letter i,
then release the Option key and immediately type i again.

CD-ROMs and At Ease
-------------------
An administrator can allow only certain CD-ROM discs to be used on a
workstation. This feature applies only to CD-ROM discs that are used from the
CD-ROM drive of the user's computer. It does not apply to discs in CD-ROM drives
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that are connected to an AppleShare file server. These drives appear to At Ease
as AppleShare volumes, not as CD-ROM drives.

Documents Created by Approved Applications
------------------------------------------
A document that is available to users may be opened if the application that
created the document is on the "approved" list of applications. At Ease creates
this list by searching locations to which the users of a setup have access,
including the setup folder, the Apple Menu Items folder, the Control Panels
folder, and the Startup Items folder.

If any documents (or stationery pads) exist in those locations, At Ease assumes
that the application that created them is also approved. For example, if the
Apple Menu Items folder contains a SimpleText stationery pad, and users of that
setup have access to "other items" in the Apple menu, those users will be able
to open any SimpleText documents, no matter where the documents are located.
This is true for both panels and for the restricted Finder.

[WG] Server Mounting in At Ease
-------------------------------
The administrator decides whether users of a particular setup can (a) start up
with the last server volumes used or (b) use the Chooser's marked startup
volumes instead. At Ease permits only one of these options for a given setup.

This option can be set in At Ease Setup (Workgroups) by selecting a setup and
then putting an X in the checkbox labeled "Always remember the user's last-used
AppleShare logins." When the checkbox is selected, any AppleShare volumes
mounted at logout will be remembered by At Ease and remounted the next time the
user logs in. When the checkbox is not selected, any server volumes that were
set in the Chooser to connect at startup will mount with the same privileges as
were set with the Chooser. Because this feature operates on a user-by-user
basis, the setting must always be the same for any user who belongs to multiple
setups.

If a server has volumes (such as a CD-ROM drive) to which you want users to have
access when they log in, you should leave the "remember" checkbox unselected and
use the Chooser to set up the volumes to be mounted on each workstation. You
must do this on each computer because the AppleShare information is stored in
the System Folder of the workstation, not on the server volume.

[WG] Disk Security
------------------
The disk security feature in At Ease prevents users from starting up a
workstation from a floppy disk and then accessing the startup disk. This feature
was introduced in At Ease 2.0. In version 3.0, you set this feature using a
checkbox labeled "Lock Startup Volume" in the User Settings dialog box.

If At Ease detects that the security option cannot be used on a workstation, it
dims the checkbox for this option. There are two primary reasons why the Lock
Startup Volume option cannot be used:

• Unknown hard disk driver
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If you have reformatted your startup disk with a non-Apple hard disk driver, the
disk security option may not work with that driver. If the Lock Startup Volume
checkbox is dimmed, please contact the driver software manufacturer to see if
that disk driver is compatible with this At Ease feature.

• Non-partitioned IDE drives

Some Macintosh computer models use a hard drive mechanism called IDE (or ATA)
for the startup disk. (Computers that use this drive type include the Power
Macintosh 5200, 5300, and 6200, and the Macintosh PowerBook models 150, 190, and
5300.)

The security in At Ease requires that the startup hard disk drives be
partitioned. All SCSI hard drives are partitioned at the factory, and in the
future the IDE drives will be partitioned. But for current Macintosh models with
IDE drives that are not partitioned, the disk security will work only if the IDE
drive is reformatted using a partitioned driver. One program that can partition
these drives is Drive7, from Casa Blanca Works. (The IDE hard drive must be
reformatted in order to partition it. You cannot update the driver on the
disk.)

At Ease and File Sharing
------------------------
Turning on file sharing on a computer using At Ease version 3.0 or 3.0.1 is not
recommended. At Ease attempts to turn off file sharing when a restricted Finder
user starts up. You should be sure that file sharing is turned off (by checking
in the Sharing Setup control panel).

[WG] Maximum Number of Connected Users on an At Ease Server
-----------------------------------------------------------
Because At Ease can open up to four files on the server for each machine that is
in the login screen, it is possible that some versions of AppleShare will not
allow as many machines to connect as may be indicated in the AppleShare Admin
File Server Preferences dialog. Version 4.2 of AppleShare should eliminate this
restriction.

Bypassing At Ease at Startup on Certain Power Macintosh Models
--------------------------------------------------------------
Certain newer Macintosh computers using system software version 7.5.2 may allow
users to bypass At Ease by holding down the Shift key when starting up. This
problem has been fixed in system software version 7.5.3, but you can also
prevent users from bypassing At Ease by clicking to put an X in the checkbox
labeled "Don't allow shift key at startup to disable extensions" in the setup
application. You may need to do this for each machine on which the problem has
occurred.

At Ease and RAM Doubler
-----------------------
RAM Doubler version 1.6 is not compatible with At Ease 3.0.1. The computer may
freeze when users launch applications from At Ease if RAM Doubler is installed.
Apple recommends that customers contact Connectix Corporation to determine
whether an updated version of RAM Doubler is available. For more information,
contact Connectix at 800-950-5880 or 415-571-5100.

..TIL20661-At_Ease_3-0-3_Updater_Read_Me_11-96_(TA36229).pdf



[WG] At Ease and Hard Disk Toolkit (HDT)
----------------------------------------
In rare cases, if your internal hard disk has been formatted with certain
versions of the Hard Disk Toolkit (HDT), activating the Lock Startup Volume
feature in At Ease for Workgroups may prevent your internal disk from starting
up. If your internal hard disk has been formatted using HDT, you should back up
the data on your hard disk before activating the Lock Startup Volume feature.
Because all internal hard disks on computers sold by Apple are formatted using
Apple software, not HDT, you will not experience this problem unless you have
reformatted the internal hard disk with HDT. To determine if your internal hard
disk has been reformatted with the Hard Disk Toolkit, select the hard disk,
choose Get Info from the File menu, and check the Info dialog box for "<name of
hard drive>, FWB."

At Ease and QuickMail
---------------------
When a user attempts to save a file from QuickMail, he or she may be prompted to
save the file in a location other than the user's documents folder. If the user
clicks Cancel and then chooses Save again, the file will be saved in the user's
documents folder.

Major Problems Corrected in Versions 3.0.1–3.0.3
================================================

Users Visible After Update From Version 2.x
-------------------------------------------
After an update from version 2.x to version 3.0, users already registered in At
Ease occasionally did not show up in the setup application. (The setup window
showed setups, but no users.) Users should appear after the automatic update
from 2.x to this version (3.0.3).

No Report of Damaged Preferences File at Login
----------------------------------------------
On some networks (especially if workstations were not turned off periodically),
a message appeared when a workstation logged in indicating that application
preferences might be damaged, even though other computers on the network were
working properly. Restarting the server usually cleared up this problem. The
problem has been fixed in versions 3.0.1 or later.

[WG] Shorter Login or Logout Times on Large Systems
---------------------------------------------------
In server-based At Ease networks with many users, workstations took an
excessively long period of time to log in or out of the system. In versions
3.0.1 and later, the login and logout times have been reduced for very large
networks. Apple recommends that you use version 4.2 (or later) of AppleShare if
you are encountering problems with long login or logout times.

[WG] Documents Panel Remains Visible
------------------------------------
When an At Ease user was logged in, a message occasionally appeared indicating
that the server had been disconnected, and the documents panel disappeared, even
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though the server volume had not actually been disconnected. This problem has
been corrected.

[WG] Setup Application Correctly Recognizes Setups
--------------------------------------------------
The setup application occasionally interpreted one or more setups as locked, so
that they could not be modified by the administrator. This problem has been
corrected.

Virex Incompatibility Corrected
-------------------------------
The Virex application was not compatible with At Ease 3.0. If both programs were
installed, the user experienced a system crash when starting up the computer.
This problem has been corrected.

Items in the Apple Menu Remain Visible
--------------------------------------
Occasionally some aliases in the Apple menu were deleted when a restricted
Finder user returned to the login screen. This problem has been corrected.

[WG] Servers Mount Correctly
----------------------------
Server volumes selected in the Chooser occasionally could not mount when a user
logged in. This problem has been corrected.

Note: This feature works only if the user's setup has the "Always remember the
user's last-used AppleShare logins" option turned off. See the user's manual for
instructions.

[WG] Import Users Function Works Correctly
------------------------------------------
A number of changes were made to the "import users" function. A problem that
prevented the cancellation of importing when many errors occurred has been
corrected.

[WG] Middle-Level Administration
--------------------------------
Middle-level administrators can now add users to setups that they own.
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